Kepler - Issues

# Tracker Status Priority Subject Assignee Updated

4337 Bug Resolved Immediate 1.0 -> 2.0 upgrade issues tracking bug Chad Berkley 02/25/2010 05:28 PM
4996 Bug Resolved Normal 2.0-RC2 demos don't work Chad Berkley 05/20/2010 04:25 AM
5309 Bug Resolved Normal 2.2.0rc1 - Preferences and Components Search (configuration) issue David Welker 02/15/2011 10:32 PM
5318 Bug Resolved Normal 2.2.0 release testing David Welker 05/24/2011 05:05 PM
5333 Bug New Normal 2.2 rc3: getenv("™) doesn't work for mac installation. Daniel Crawl 08/21/2015 04:03 PM
5334 Bug Resolved Normal 2.2 rc3: kepler.sh file is not executable by default in Kepler.app/Contents/Resources/Java/ directory | David Welker 03/01/2011 05:21 PM
5726 Bug Resolved Normal actor names ending in digit renamed on canvas Daniel Crawl 07/03/2013 04:52 PM
2112 Bug Resolved Normal add default data browse heirarchy Chad Berkley 11/02/2005 04:55 PM
5129 Bug In Progress Normal adding and removing configuration properties could be made easier Derik Barseghian 03/19/2013 03:59 PM
2340 Bug Resolved Normal Adding new actor to actor tree does not work Chad Berkley 01/24/2006 11:09 AM
2115 Bug Resolved Normal add simple annotation dialog for now Chad Berkley 06/10/2005 01:26 PM
4665 Bug Resolved Immediate Add unit tests for kar functionality Chad Berkley 02/05/2010 12:49 PM
2111 Bug Resolved Normal Add "view data" capability for data sources Chad Berkley 11/02/2005 04:52 PM
5892 Bug Resolved Normal After running various demos like HelloWorld, the user is prompted to save changes to kar Daniel Crawl 03/19/2013 02:42 PM
5084 Bug Resolved Normal Allow test releases in the same location as actual releases. David Welker 09/20/2010 11:18 PM
5247 Bug Resolved Normal Allow user to set memory allocated to Kepler from within Kepler Derik Barseghian 08/06/2012 03:29 PM
4300 Bug New Normal Animate at Runtime" checkbox stays checked when director is replaced Timothy McPhillips 08/26/2009 02:30 PM
3552 Bug In Progress Normal Annotation elements in trace file do not appear in details pane of provenance browser Timothy McPhillips 04/03/2009 02:18 PM
3254 Bug Resolved Normal Annotations for some Ptolemy demos are not wrapped Christopher Brooks 05/07/2008 03:46 PM
3925 Bug Resolved Normal ant run does not always work from paths with spaces David Welker 08/20/2009 03:51 PM
3261 Bug Resolved Normal ApplicationFramework/CredentialRetrieve workflow has problems Chad Berkley 05/07/2008 04:09 PM
4523 Bug Resolved Normal apply button while editing ports acts like commit Chad Berkley 11/03/2009 07:00 PM
3546 Bug New Normal Automatically load trace for a completed run into the provenance browser Timothy McPhillips 04/03/2009 02:49 PM
3149 Bug New Normal cannot add arbitrary jars when exporting archive Chad Berkley 04/22/2009 03:37 PM
3529 Bug Resolved Normal cannot always set parameters when running workflow from command line Chad Berkley 07/21/2009 11:31 AM
2558 Bug Resolved Normal Cannot create a new 'kar' file for modified actor Chad Berkley 11/21/2006 10:04 AM
4410 Bug Resolved Normal Cannot open KARs from arbitrary location on disk Aaron Aaron 11/18/2009 09:12 AM
5419 Bug Resolved Normal Cannot open KARs saved in 2.1.0 suites in 2.2.0 in relaxed mode because ptolemy module David Welker 07/13/2011 02:24 PM

changed names
5448 Bug Resolved Normal cannot start Kepler using non-lcedTea OpenJDK Christopher Brooks 06/15/2012 11:48 AM
4510 Bug Resolved Normal can't add local repository if its name begins with the name of another local repository Aaron Aaron 11/04/2009 11:36 AM
4033 Bug Resolved Normal Can't compile, MakeKars not found Chad Berkley 04/29/2009 02:27 AM
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4560 Bug Resolved Normal can't remove local repositories Chad Berkley 01/12/2010 05:10 PM
1846 Bug Resolved Normal can't resize left pane (actor/data tab section) Chad Berkley 01/11/2005 01:51 PM
4143 Bug Resolved Normal "change failed" error while copy/paste-ing an Imaged actor Chad Berkley 06/11/2009 08:36 AM
1640 Bug Resolved Normal change kepler website to the seek wiki style Steve Tekell 01/20/2005 10:17 AM
4869 Bug In Progress Normal changes made to workflows during dialogs before committing (Edit Parameters/Cancel) ben leinfelder 05/25/2010 11:52 AM
2196 Bug Resolved Normal Changes to DarwinCoreDataSource.java DarwinCoreMetaDataSpecification.java Chad Berkley 09/13/2005 02:12 PM
4530 Bug Resolved Normal changing a KAR outside of a Kepler session fails without a clean-cache Chad Berkley 11/04/2009 08:57 AM
5070 Bug Resolved Normal Changing the "Available Modules" tab in the Module Manager to "Available Suites and Modules" David Welker 08/11/2010 12:59 PM
4681 Bug Resolved Normal Check all file properties before release Chad Berkley 04/28/2010 01:25 PM
3182 Bug Resolved Immediate check for consistent licensing text in all source files Timothy McPhillips 04/23/2008 10:02 AM
5722 Bug Resolved Normal Check for problems with sanitized RecordToken labels Daniel Crawl 08/14/2015 04:18 PM
1912 Bug Resolved Normal cleanup ImageJ actor to avoid multiple copies of menus Dan Higgins 02/09/2005 01:18 PM
4565 Bug Resolved Normal clean wrp checkout has no actors Chad Berkley 11/19/2009 07:55 PM
5314 Bug New Normal Closing last workflow window closes Kepler application David Welker 02/18/2011 05:58 AM
1590 Bug Resolved Normal coding guidelines Chad Berkley 02/08/2005 09:25 AM
3547 Bug Resolved Normal CollectionReader actor throws exception when input file contains Metadata or Parameter elements | Timothy McPhillips 10/22/2008 01:29 PM
3560 Bug New Normal Color-code contents of CollectionDisplay Timothy McPhillips 04/03/2009 02:50 PM
4046 Bug New Normal ComadTest should report more details when detecting an error Timothy McPhillips 05/01/2009 01:05 PM
3586 Bug Resolved Normal COMAD traces should be reproducible when there is limited concurrency Timothy McPhillips 04/24/2009 02:27 PM
2706 Bug Resolved Normal Compile failure under Java 1.6 in DBConnection class Chad Berkley 01/17/2007 04:07 PM
5276 Bug New Normal component search performance is poor Jing Tao 08/19/2015 10:41 AM
4925 Bug Resolved Normal Components search occasionally shows different results Aaron Aaron 04/12/2010 01:16 PM
4563 Bug Resolved Normal components search seems to be broken Chad Berkley 12/14/2009 07:38 PM
3671 Bug New Normal Configurable workspace directory for holding workflows, data, and run products Timothy McPhillips 04/03/2009 03:18 PM
4782 Bug Resolved Normal configuration files do not load with non en_US locale Chad Berkley 02/09/2010 01:55 PM
4804 Bug Resolved Normal copy/paste relation changes width from Auto to 1 Christopher Brooks 03/24/2010 04:57 PM
2318 Bug Resolved Normal Copyrights and licenses of subpackages need to be handled Timothy McPhillips 05/01/2008 03:21 PM
4060 Bug Resolved Normal Copyrights need to be updated to 2009 Chad Berkley 05/13/2009 11:59 AM
5025 Bug Resolved Normal Couldn't run the workflows 00-StatisticalSummary and 08-CommandLine_2 Derik Barseghian 05/26/2010 02:41 PM
4631 Bug Resolved Normal Could use some way to change the "workflow name" stored in a KAR Chad Berkley 01/20/2010 03:54 PM
2137 Bug Resolved Normal create a docbook format for WF documentation llkay Altintas 11/02/2005 01:04 PM
5006 Bug Resolved Normal create and copy demo dir directory into KeplerData on startup if doesn't exist Derik Barseghian 05/13/2010 02:54 PM
4685 Bug Resolved Normal Create installers Chad Berkley 03/09/2010 04:08 PM
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1835 Bug Resolved Normal create jni cookbook for creating jni actors Chad Berkley 01/05/2005 08:58 AM
2415 Bug Resolved Normal Create KAR from Actor bug (on Mac) Chad Berkley 04/16/2006 07:20 PM
4630 Bug Resolved Normal creating and changing relations don't trigger LSID bump Aaron Aaron 01/26/2010 02:52 AM
4273 Bug New Normal Ctrl+E operates on mouse position, not selection Chad Berkley 10/29/2009 01:30 PM
5701 Bug Resolved Normal CT was removed, demo workflows need to be updated Daniel Crawl 09/14/2012 09:22 PM
5154 Bug Resolved Normal Curiously, no progress indicator shows progress during patching. David Welker 08/18/2010 06:53 PM
2556 Bug Resolved Normal "Customize Name' menu missing Dan Higgins 10/02/2006 04:15 PM
4570 Bug Resolved Normal dangling file handle for KARs Aaron Aaron 01/25/2010 04:45 PM
3143 Bug New Normal dataFrame_R cache problem under parallels Chad Berkley 04/03/2009 02:18 PM
1990 Bug Resolved Normal DataType of EML for KEPLER Jing Tao 03/25/2005 05:04 PM
5454 Bug Resolved Normal DEBUG->ANIMATE EXECUTION error message David Welker 08/06/2011 10:50 AM
5194 Bug Resolved Normal demos are difficult to find Daniel Crawl 07/13/2012 03:43 PM
3134 Bug Resolved Normal demo workflow 02-LotkaVolterraPredatorPrey.xml needs windows resaved Chad Berkley 02/07/2008 04:24 PM
1892 Bug Resolved Normal Design an interface to optionally log inputs, parameters and intermediate results llkay Altintas 10/17/2005 11:08 AM
5179 Bug Resolved Normal determine if ptolemy 8.0.0 is the desired version for kepler 2.1.0 release Christopher Brooks 09/28/2010 03:21 PM
5173 Bug New Normal Develop clear criteria for when code in Kepler CORE should be in its own module. llkay Altintas 06/15/2012 12:27 PM
4161 Bug Resolved Immediate Develop kepler workflow execution engine Jing Tao 04/19/2010 01:16 PM
5157 Bug Resolved Normal Devise approach for when patching should occur when changes occur via the module-manager. David Welker 09/08/2010 03:25 PM
3270 Bug Resolved Normal disable DIGIR Data Source by default ben leinfelder 05/09/2008 11:07 AM
3255 Bug Resolved Normal Diva ConcurrentModificationException Christopher Brooks 04/30/2008 11:54 PM
4731 Bug Resolved Normal Documentation Customize on directors and parameters gives ClassCastException Aaron Aaron 02/04/2010 03:54 PM
5178 Bug Resolved Normal Documentation links are broken in help doc-index.html Derik Barseghian 09/28/2010 03:13 PM
1901 Bug Resolved Immediate Documentation system llkay Altintas 10/17/2005 10:52 AM
1900 Bug Resolved Immediate Documentation system llkay Altintas 01/21/2005 11:45 AM
2853 Bug Resolved Normal Documentation (where to save it; customization) Chad Berkley 02/28/2008 11:03 AM
5237 Bug Resolved Normal Downloading kars on os X 10.6 locks Kepler Chad Berkley 11/10/2010 02:14 PM
5564 Bug Resolved Normal dragging sdf director to the canvas causes exception Derik Barseghian 12/06/2011 07:29 PM
4715 Bug Resolved Normal Eclipse metadata in webservice module breaks eclipse project import Chad Berkley 01/30/2010 12:30 AM
3206 Bug Resolved Normal ecogrid error message occurs when running disconnected from network Jing Tao 04/16/2008 03:59 PM
3209 Bug Resolved Normal ecogrid SearchRegistryAction error when disconnected from network Jing Tao 04/17/2008 05:28 PM
1717 Bug Resolved Immediate EML200 data source throws error on 'Look Inside’ Rod Spears 11/02/2005 01:04 PM
2373 Bug Resolved Normal EMLDataSource metadata menu no longer available Chad Berkley 02/28/2006 02:20 PM
2050 Bug Resolved Normal EMLDataSource output as Ptolemy records Jing Tao 04/08/2005 03:26 PM
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5177 Bug New Normal Enhance displaying workflow in kepler server library skin Chad Berkley 09/15/2010 05:43 PM
3555 Bug New Normal enhancements to Trace File view in provenance browser Timothy McPhillips 04/03/2009 02:49 PM
3266 Bug In Progress Normal ENM/GARP_MultipleSpecies-V.xml problems Chad Berkley 04/03/2009 02:18 PM
3267 Bug Resolved Normal ENM/GARP_SingleSpecies_BestRuleSet-1V.xml problems Chad Berkley 05/07/2008 09:59 PM
3292 Bug New Normal ENM/GDAL_h1K_NS workflow giving an exception Chad Berkley 04/03/2009 02:18 PM
2253 Bug Resolved Normal ENM Workflows errors on newer, faster computer Dan Higgins 11/08/2005 12:42 PM
4178 Bug Resolved Normal error handling with MoMLCommandLineApplication Christopher Brooks 07/10/2009 06:01 PM
3943 Bug New Normal error importing more than one actor created in one suite using kepler-1.0 Chad Berkley 04/08/2009 11:39 AM
4767 Bug Resolved Normal error instantiating actor with port types from KAR Aaron Aaron 04/12/2010 05:56 PM
4846 Bug Resolved Normal error opening kar from local repository Chad Berkley 07/12/2012 04:11 PM
3388 Bug New Normal error running simihofi.xml workflow in Kepler 1.0.0 Derik Barseghian 04/03/2009 02:44 PM
5331 Bug Resolved Normal Errors in Help->Kepler Documentation page at kepler 2.2 rc3. David Welker 03/01/2011 04:28 PM
4955 Bug Resolved Normal Error trying to instantiate workflow from Outline tab Aaron Aaron 04/26/2010 02:21 PM
1766 Bug Resolved Normal Error with Ecogrid searches for JVM 1.4.2_05 and _06 Jing Tao 11/02/2005 01:04 PM
3086 Bug Resolved Normal Error with kepler20080122.zip version (PTII?) Chad Berkley 01/22/2008 03:54 PM
3226 Bug New Normal Eval: subplots from RExpression overly condensed Chad Berkley 04/03/2009 02:18 PM
4926 Bug Resolved Normal Examine Kepler for duplicated Ptolemy code Christopher Brooks 08/06/2012 05:00 PM
3020 Bug Resolved Normal Exporting an actor to a kar does not include internal jars Dan Higgins 01/17/2008 12:10 PM
4068 Bug Resolved Normal File Menu should display 5 most recently used workflows Daniel Crawl 08/18/2012 04:57 PM
2889 Bug Resolved Normal fileName in ConfigXML.java not getting set Derik Barseghian 12/13/2007 02:18 PM
4912 Bug Resolved Normal File => New Workflow => FSM Model and Modal Model don't work Sean Riddle 04/14/2010 04:02 PM
5414 Bug Resolved Normal fileparameter browse has NPE Christopher Brooks 05/31/2011 02:47 PM
4514 Bug Resolved Immediate Files are being saved in the Kepler installation directory Aaron Aaron 12/17/2009 06:47 PM
5411 Bug Resolved Normal file->save to xml does not work David Welker 06/10/2011 12:40 PM
3196 Bug Resolved Immediate Find/Change license on gpl/Igpl code Timothy McPhillips 05/01/2008 09:23 AM
5227 Bug Resolved Normal Finish work on installers. David Welker 11/29/2010 02:54 PM
5183 Bug Resolved Normal Fix 6-WebServicesAndDataTransformation.xml jianwu jianwu 09/22/2010 05:33 PM
5167 Bug Resolved Normal Fix bug so that the correct modules.ixt is always used. David Welker 12/01/2010 03:44 PM
5066 Bug Resolved Normal Fix for ImagedJ so that preferences are stored in an area other than the installation space. This may | David Welker 07/06/2010 05:58 PM

require a change to ImageJ source code.
2144 Bug Resolved Immediate fix functionality and GUI issues with query builder Jing Tao 11/01/2005 02:34 PM
1821 Bug Resolved Normal Fix improperly names returnfield Rod Spears 12/16/2004 01:14 PM
2819 Bug Resolved Normal Fix the menu command to build Composite from selection Chad Berkley 09/05/2007 02:29 PM
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5075 Bug New Normal Fix the module manager so it can show docs with any name. David Welker 07/14/2010 10:27 AM
5074 Bug Resolved Normal Fix the release process so modules can be released from Windows machines. David Welker 09/09/2010 09:47 PM
4522 Bug Resolved Normal Folder not found in library index Chad Berkley 12/27/2009 11:10 AM
3075 Bug Resolved Normal Fold Top,java file in $KEPLER/src/exp/ dir into Ptolemy src Chad Berkley 01/24/2008 05:01 PM
3105 Bug Resolved Normal Getting Started link on Welcome Page should lead to demos Chad Berkley 01/29/2008 10:19 AM
4532 Bug New Normal have to manually click Build to rename repositories Chad Berkley 01/13/2010 02:16 PM
4561 Bug New Normal icon overlays not showing up for actors in the components tree Chad Berkley 01/13/2010 04:05 PM
5712 Bug Resolved Normal illegal option chmod error during Kepler startup Derik Barseghian 10/30/2012 03:46 PM
2912 Bug Resolved Normal Immediate repeat of dragging an actor from tree to ws fails Dan Higgins 08/27/2007 10:55 AM
1914 Bug In Progress Normal Implement the 'most recently used' concept for workflows and actors Dan Higgins 04/03/2009 02:18 PM
5099 Bug Resolved Normal Import Dependent Modules for KAR doesn't work Derik Barseghian 08/25/2010 05:03 PM
3054 Bug Resolved Immediate Importing a kar file claims actor is already cached Chad Berkley 01/15/2008 12:48 PM
5071 Bug Resolved Normal Improve the installer so that it is automated instead of requiring so many manual steps. Also, David Welker 12/07/2010 06:33 PM

develop streamlined release process so that minor releases 2.1, 2.2, etc. can be accomplished

more rapidly.
2388 Bug New Normal Incorporating the SRB actors with the gsi authentication framework Nandita Mangal 04/06/2009 10:20 AM
5073 Bug Resolved Normal In module manager, display the current suite name as well as a fully resolved list of modules. David Welker 09/05/2010 10:15 PM
5065 Bug Resolved Normal In shared or administrative installations, the ability to store modules.txt and extra modules locally. David Welker 09/01/2010 01:02 AM

This way, the module manager will work smoothly on Windows without having to run as an

administrator.
4847 Bug Resolved Normal Instantiating new actor from library gives error after restart Aaron Aaron 03/12/2010 01:57 PM
4577 Bug New Normal integrate, and separate from save/export, the code for Uploading Derik Barseghian 02/11/2010 04:32 PM
4350 Bug Resolved Normal Integrity constraint violation - no parent SYS_FK_59 table - during _first_ startup Chad Berkley 01/13/2010 02:28 PM
5068 Bug New Normal Investigate jars (why they are necessary) and upgrade whenever possible. David Welker 07/07/2010 10:27 AM
3291 Bug New Normal IPCC_ChangeNightlyBuildTest got an exception Chad Berkley 04/03/2009 02:18 PM
5018 Bug New Normal Iltems with the same LSID show with the same name in the Components Library Chad Berkley 05/19/2010 04:36 PM
1905 Bug Resolved Normal jar file cleanup Dan Higgins 02/09/2005 01:09 PM
3027 Bug Resolved Immediate jar handling issues Chad Berkley 02/25/2010 03:11 AM
4095 Bug New Normal Java Package Ontology (e.g. to facilitate Ptolemy component access) Timothy McPhillips 08/12/2009 03:28 PM
4482 Bug Resolved Normal JRE Exception Access Violations Chad Berkley 01/13/2010 02:30 PM
4419 Bug Resolved Normal KARFile openKARContents problem with open success Aaron Aaron 09/29/2009 05:35 PM
4802 Bug Resolved Normal KARs in KeplerData/workflows are being parsed on startup Aaron Aaron 03/04/2010 04:44 PM
2817 Bug Resolved Normal kepler-1.0.0beta3.exe not finding valid java install Dan Higgins 12/11/2007 10:04 AM
5064 Bug New Normal Kepler 2.1 Tracking Bug David Welker 07/09/2010 03:58 PM
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5345 Bug Resolved Normal Kepler 2.2rc3 Copyright should be updated to 2011 David Welker 06/01/2011 07:18 PM
4113 Bug New Normal Kepler changes property position in XML but keeps values Chad Berkley 08/12/2009 03:16 PM
4360 Bug New Normal Kepler gets slow under XP Chad Berkley 01/13/2010 02:27 PM
5145 Bug Resolved Normal kepler library skin is mostly broken Jing Tao 09/15/2010 05:46 PM
1872 Bug Resolved Normal kepler possibly not picking up changes as entered Chad Berkley 01/24/2006 11:11 AM
2407 Bug Resolved Normal Kepler process keeps running after close all windows Nandita Mangal 04/13/2006 11:54 AM
5162 Bug New Normal Kepler quits with JVM error (no use-case for reproducing error) Chad Berkley 08/27/2010 10:30 AM
5344 Bug New Normal Kepler ships open source software and needs to include license files David Welker 03/09/2011 08:28 AM
3204 Bug New Normal Kepler should have FSM examples Chad Berkley 04/03/2009 02:18 PM
4194 Bug Resolved Normal Kepler should have the Continous and Modal domains Christopher Brooks 01/26/2010 05:37 PM
5745 Bug Resolved Normal "./kepler.sh -runwf -nogui -nocache workflow.xml" has error message after execution. jianwu jianwu 11/26/2012 02:47 PM
5596 Bug New Normal Kepler Ul freezes after Login Anonymously Derik Barseghian 05/03/2012 08:04 AM
3991 Bug Resolved Normal large workflow errors ben leinfelder 08/13/2009 12:11 PM
2518 Bug Resolved Normal Librarylndex 'read' method does not work correctly Dan Higgins 06/26/2007 02:16 PM
5688 Bug Resolved Normal library not working in kepler trunk in windows?7 Derik Barseghian 09/07/2012 11:03 AM
5402 Bug Resolved Normal Linux build at r27617 can't drag instantiate components David Welker 05/13/2011 03:58 PM
5228 Bug Resolved Normal Load splash screen and icons from the classpath, not specific modules. David Welker 12/01/2010 02:46 PM
4559 Bug Resolved Immediate local repositories not showing up in components tree Aaron Aaron 01/28/2010 10:38 AM
4812 Bug New Normal local repository KAR [right click]->Delete fails when file does not exist Chad Berkley 02/18/2010 05:18 PM
1690 Bug Resolved Normal Lock up of Kepler when trying to open Utilities/Deocatrive menu Chad Berkley 09/15/2004 04:11 PM
4261 Bug Resolved Normal Long file name on windows Christopher Brooks 06/12/2012 08:35 AM
4303 Bug Resolved Normal LSID Component Search Aaron Aaron 10/06/2009 02:19 PM
4633 Bug Resolved Immediate LSID conflicts Aaron Aaron 01/27/2010 04:54 PM
3109 Bug Resolved Immediate Many demos linked to getting started don't work Chad Berkley 01/29/2008 11:34 AM
5576 Bug Resolved Normal memory leak in ptolemy.data.expr.CachedMethod Daniel Crawl 06/25/2012 11:20 AM
4642 Bug New Normal memory usage & slowdowns jilanwu jianwu 08/23/2015 02:28 PM
5076 Bug New Normal Minimize the number of files downloaded from the Ptolemy repository. David Welker 07/07/2010 10:37 AM
4512 Bug Resolved Normal missing entries with multiple copies of the same KAR file in a single repository Aaron Aaron 12/05/2009 01:19 PM
5093 Bug Resolved Normal module manager can leave kepler in broken or unexpected states David Welker 10/28/2010 06:42 AM
3559 Bug New Normal month field in trace file name is off by one Timothy McPhillips 04/03/2009 02:50 PM
4111 Bug Resolved Immediate move test data to a more appropriate locations Chad Berkley 06/02/2009 03:21 PM
5072 Bug Resolved Normal Move the R module out of Kepler/CORE entirely. Derik Barseghian 06/15/2012 12:33 PM
4789 Bug Resolved Normal multiport input to composite actor seems to only pass first token Chad Berkley 02/17/2010 12:26 PM
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5621 Bug Resolved Immediate Need change the access order type from denyFirst to allowFirst in kepler when it generate emls Jing Tao 08/23/2012 11:39 AM
2138 Bug Resolved Normal need helloworld WF Chad Berkley 07/05/2005 03:29 PM
3036 Bug Resolved Normal Need to be able to delete actors from the library Chad Berkley 03/17/2008 01:33 PM
2347 Bug Resolved Normal Need to be able to terminate workflow 'animation/feedback’ Chad Berkley 02/02/2006 01:07 PM
3115 Bug Resolved Normal Need to check Kepler for memory leaks Sean Riddle 04/22/2008 05:30 PM
5034 Bug Resolved Normal Need to generalize copying workflow demos from areas other than outreach. Derik Barseghian 06/07/2010 03:59 PM
4338 Bug Resolved Immediate need to review usability and gui of module manager Chad Berkley 01/19/2010 09:58 AM
1751 Bug Resolved Normal new mailing lists: kepler-users, kepler-votes Matt Jones 11/02/2005 12:27 PM
4094 Bug Resolved Normal new Unnamed windows should have a suffix that increments Derik Barseghian 07/09/2009 11:21 AM
1886 Bug Resolved Normal nightly build system revisited Chad Berkley 02/14/2005 01:19 PM
5271 Bug New Normal No-gui mode needs a way to access private data source David Welker 01/12/2011 02:10 PM
5270 Bug Resolved Normal No menu bar and labels when non-default locale is set David Welker 08/04/2011 09:55 AM
4087 Bug New Normal No reset/x button to clear component searches Derik Barseghian 01/13/2010 04:01 PM
4567 Bug Resolved Normal NPE viewing LSID of non-workflow entries in local repositories Chad Berkley 11/23/2009 10:15 AM
4529 Bug Resolved Normal NPE while saving KAR crashes Kepler Aaron Aaron 11/18/2009 08:59 AM
2062 Bug Resolved Normal Number of search results in data panel doesn't match the real result Jing Tao 04/13/2005 02:40 PM
2485 Bug Resolved Normal On Macintosh, cannot connect from a relation Dan Higgins 11/21/2006 09:41 AM
5193 Bug Resolved Normal Open menu items should be merged into one David Welker 12/10/2010 11:25 PM
3566 Bug New Normal order collection contents displayed in provenance browser? Timothy McPhillips 04/03/2009 02:50 PM
2254 Bug Resolved Normal Order of actors in list changes with every new launch of Kepler Chad Berkley 01/24/2006 11:14 AM
4911 Bug Resolved Normal org.kepler.gui.RunWithFeedbackChkBoxAction exception message. Chad Berkley 03/29/2010 04:56 PM
5623 Bug Resolved Normal Outline tab context menu problems Daniel Crawl 06/15/2012 04:02 PM
4801 Bug In Progress Normal out of memory jianwu jianwu 08/23/2015 02:29 PM
5636 Bug Resolved Normal outreach/demos/Database/Database_example_1.xml workflow fails jianwu jianwu 06/27/2012 04:47 PM
5691 Bug New Low parameter choices are not saved Derik Barseghian 09/18/2012 11:56 AM
6000 Bug Closed Normal parameter copy-paste exception on console. Christopher Brooks 11/18/2013 02:19 PM
3722 Bug Resolved Normal parameters cannot be dragged onto the canvas Chad Berkley 01/07/2009 04:12 PM
3361 Bug In Progress Normal parameters lose their Display Name when copy and pasted Derik Barseghian 04/03/2009 02:18 PM
5435 Bug New Normal passing string into a parameter for headless execution doesn't work David Welker 06/30/2011 04:53 PM
1849 Bug Resolved Normal pasting operation pastes directly over copied object Chad Berkley 01/07/2005 06:34 PM
5166 Bug Resolved Normal Patch Kepler 2.0.0 so that the module manager can switch from Kepler-2.2.0 to Kepler-2.0.0 or David Welker 12/01/2010 02:55 PM

Kepler-2.0.1
2195 Bug Resolved Normal Patch to org.ecoinformatics.seek.datasource. to remove unused imports Chad Berkley 09/13/2005 02:10 PM
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3256 Bug Resolved Normal path problems on Mac with CommandLine demo workflows Chad Berkley 05/07/2008 04:01 PM
5229 Bug Resolved Normal Poor component search performance Chad Berkley 02/04/2011 01:17 PM
2472 Bug Resolved Normal Port locations not saved with Composites in 'Save in Library...' Dan Higgins 04/12/2007 01:47 PM
4139 Bug In Progress Low port names are displayed twice Chad Berkley 09/23/2009 08:25 AM
5631 Bug New Normal PortParameters cannot be drag-instantiated from Outline/ltems of Interest trees Derik Barseghian 06/19/2012 01:23 PM
4915 Bug Resolved Normal PortParameters instantiated from Outline tab cannot be deleted Derik Barseghian 05/12/2010 04:46 PM
1910 Bug Resolved Normal Ports on datasource actors do no appear until actor is moved Rod Spears 02/01/2005 01:14 PM
5628 Bug New Normal possible to get NPE when right-clicking on kar in Components tree Derik Barseghian 06/15/2012 04:25 PM
2920 Bug Resolved Normal Problem adding context menus in Kepler Chad Berkley 12/13/2007 01:53 PM
2439 Bug Resolved Normal Problem creating KAR from instantiated actor Chad Berkley 05/18/2007 11:43 AM
1913 Bug Resolved Normal Problem running workflow after it is saved Chad Berkley 11/03/2005 09:37 AM
2432 Bug Resolved Normal problems saving kars from saved actors Chad Berkley 04/06/2007 02:30 PM
4986 Bug Resolved Normal Problem with property DEMODIR on Windows XP Derik Barseghian 05/13/2010 02:54 PM
4985 Bug Resolved Normal problem with workflows using Rexpression on Windows XP Derik Barseghian 05/26/2010 03:08 PM
3585 Bug New Normal Provide API for creating output files during a workflow run Timothy McPhillips 04/03/2009 03:18 PM
2009 Bug Resolved Normal Provide Cancel for Search Function Chad Berkley 05/16/2005 09:05 AM
2010 Bug Resolved Normal Provide Clear/Reset for Search Chad Berkley 11/02/2005 04:21 PM
3557 Bug New Normal Provide data dependency graph view in provenance browser Timothy McPhillips 04/03/2009 02:49 PM
2124 Bug Resolved Normal provide mechanism for user to see available nodes on ecogrid Chad Berkley 11/02/2005 05:08 PM
2025 Bug Resolved Normal provide workflow and results in some publishable format Chad Berkley 11/02/2005 04:32 PM
3162 Bug Resolved Normal ptExecuteConfig.xml depends on removed basicKeplerLibrary.xml Chad Berkley 04/02/2008 04:32 PM
2319 Bug Resolved Normal Ptolemy build problems Dan Higgins 04/03/2009 02:26 PM
3874 Bug Resolved Normal ptolemy.util.StringUtilities.mergePropertiesFile() deletes properties Christopher Brooks 07/08/2009 09:28 AM
5186 Bug Resolved Normal Publish example KARs to repository Derik Barseghian 07/08/2011 06:33 PM
3295 Bug New Normal Python/Ptolemnizer welcome text does not display Derik Barseghian 04/03/2009 02:18 PM
3268 Bug Resolved Normal Python/PythonFileLineCounter.xml workflow problem Chad Berkley 05/07/2008 06:01 PM
1898 Bug Closed Normal Redesign the web service harvester and create design documentation llkay Altintas 11/24/2009 03:53 AM
5174 Bug Resolved Normal Reduce the number of modules in Kepler CORE. llkay Altintas 06/15/2012 12:06 PM
4684 Bug Resolved Immediate Release tracking bug Chad Berkley 03/10/2010 01:53 PM
4347 Bug Resolved Normal Reminder "bug" for manual testing before 2.0 release Chad Berkley 01/13/2010 03:51 PM
4953 Bug In Progress Normal Remote Components category sticks around sometimes Derik Barseghian 08/17/2015 08:56 AM
5233 Bug Resolved Normal Remote component search messes up returns which have the same karFileName in kar xml Jing Tao 11/03/2010 05:58 PM
5689 Bug New Low remove configs/.../configuration.xml override Daniel Crawl 08/21/2015 03:54 PM
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5573 Bug Resolved Normal remove ptolemy vendors/ Christopher Brooks 03/07/2013 02:25 PM
2368 Bug Resolved Normal Remove svg icon properties from Workflow MOML files Dan Higgins 12/10/2007 01:37 PM
2323 Bug Resolved Normal Remove text added with "Attribute” actor from older workflows Dan Higgins 12/10/2007 01:27 PM
5396 Bug Resolved Normal rename ptolemy-8.1.0 module for the kepler 2.2 release David Welker 05/25/2011 04:44 PM
5089 Bug Resolved Normal Replace operating system specific files with operating system specific modules. David Welker 07/22/2010 08:59 PM
4527 Bug Resolved Immediate reports cannot be loaded when InstanceAuthNamespace changes ben leinfelder 11/06/2009 09:05 AM
5008 Bug Resolved Normal Research Copyrights before 2.0.0 release. David Welker 06/16/2010 09:20 AM
5147 Bug Resolved Normal Resolve issue with modules.txt David Welker 08/20/2010 12:08 AM
1902 Bug Resolved Normal review all useablity reports for specific bugs not already entered Dan Higgins 01/24/2005 02:55 PM
4914 Bug Resolved Normal right-clicking on any item in Outline view gives exceptions Aaron Aaron 03/30/2010 01:32 PM
4810 Bug New Normal [right click]->Save Archive (KAR) on composite actor borks port attributes Chad Berkley 02/18/2010 01:40 PM
4662 Bug Resolved Normal roll revision vs. new object ID ben leinfelder 02/10/2010 10:12 AM
5019 Bug Resolved Normal R_output_example.xml fails Chad Berkley 05/20/2010 11:32 AM
3902 Bug Resolved Normal Running Kepler from Eclipse...No actors on right pane Chad Berkley 04/06/2009 12:07 PM
4916 Bug Resolved Normal Save Archive gives an error Aaron Aaron 04/05/2010 05:03 PM
4546 Bug Resolved Normal Save Archive on an actor quits Kepler ben leinfelder 11/18/2009 10:05 AM
4973 Bug Resolved Normal Save Archive sometimes saves more or less than it should in WRP Derik Barseghian 05/17/2010 01:56 PM
5725 Bug Resolved Normal Save dialog's folder drop-down menu crashes kepler in OS X 10.8 w/ 64-bit java Derik Barseghian 03/14/2013 10:09 AM

1.6.0_37-b06-434-11M3909

3220 Bug New Normal "Save" from TextEditor interferes with workflow save-before-closing prompt ben leinfelder 09/03/2009 04:20 PM
4150 Bug Resolved Immediate Save in Library broken Aaron Aaron 12/02/2009 01:00 PM
2330 Bug Resolved Normal Saving a workflow doesn't add .xml or .moml extenders Chad Berkley 02/13/2006 03:27 PM
2978 Bug Resolved Normal saving to actor library from kepler no longer consistently works and port information is lost Dan Higgins 01/18/2008 11:21 AM
5412 Bug Resolved Normal saving with an open plot window crashes David Welker 06/10/2011 12:42 PM
4450 Bug Resolved Normal Saving workflow in Windows 7 Chad Berkley 10/16/2009 03:26 PM
5230 Bug Resolved Normal saving workflow that has instances of user created class to a KAR gives errors Chad Berkley 10/29/2010 10:23 AM
4519 Bug New Normal SDF Director cannot schedule when composite actor input port is disconnected Chad Berkley 01/13/2010 02:18 PM
2426 Bug Resolved Normal Search for image' in actor tree 'hangs' window in nightly build Dan Higgins 12/10/2007 01:54 PM
4870 Bug New Normal searching for packages with the same name from multiple sources sometimes loses results Chad Berkley 03/04/2010 02:23 PM
2458 Bug Resolved Normal Search problems with multiple actor ontologies Shawn Bowers 12/11/2007 10:00 AM
1834 Bug Resolved Normal search progress bar does not work on OSX Jing Tao 03/01/2005 10:37 AM
1837 Bug Resolved Normal Second and thrid searches return same resultset for DarwinCore DataSource Rod Spears 12/17/2004 05:25 AM
5670 Bug New Normal see if runtimemonitor module can be deleted, contains duplicate code Derik Barseghian 08/10/2012 12:01 PM
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4997 Bug Resolved Normal SEEK/garpModel_Imaged.xml has an exception while opening David Welker 06/09/2010 01:38 PM
5051 Bug Resolved Normal Semantically annotate during Save Archive a workflow with remote data set Error Chad Berkley 07/07/2010 10:45 AM
4697 Bug Resolved Normal Semantic Annotation does not increment LSID revision Derik Barseghian 02/09/2010 02:01 PM
3363 Bug Resolved Normal Show name checkbox does nothing for most Parameters Christopher Brooks 04/25/2009 12:25 PM
3734 Bug Resolved Immediate Some demos no longer work after new build/repos Chad Berkley 06/03/2009 03:37 PM
2448 Bug Resolved Normal Splash screen sometimes appears as simple white box Chad Berkley 04/03/2009 02:01 PM
3558 Bug New Normal Store each workflow run trace in it's own directory Timothy McPhillips 04/03/2009 02:50 PM
6587 Feature New Low summarize missing actors Daniel Crawl 08/17/2015 09:30 AM
3576 Bug New Normal support for accessing cascading metadata from within CompositeCoactor Timothy McPhillips 04/03/2009 03:18 PM
3574 Bug New Normal Support for importing directory contents using CollectionSource Timothy McPhillips 04/03/2009 03:18 PM
3573 Bug New Normal Support for importing file contents automatically using CollectionSource Timothy McPhillips 04/03/2009 02:51 PM
3568 Bug New Normal support for writing COMAD-style trace files from the Provenance Recorder Timothy McPhillips 04/03/2009 02:50 PM
1997 Bug New Normal Support Getting Metadata for Darwin Core search result item Jing Tao 04/03/2009 02:18 PM
3669 Bug Resolved Normal Tabbed pane interface for holding workflow canvas and additional GUI elements Timothy McPhillips 04/03/2009 03:13 PM
4458 Bug New Normal test for moving kepler directory Derik Barseghian 02/11/2010 04:33 PM
5095 Bug In Progress Immediate test kepler and wrp for memory leaks jilanwu jianwu 04/22/2011 02:52 PM
5249 Bug In Progress Immediate test kepler for memory leaks jianwu jianwu 08/23/2015 02:28 PM
5069 Bug New Normal The ability to create user manuals from a wiki that is continuously updated. David Welker 07/22/2010 10:52 AM
3915 Bug New Immediate The error dialogue won't go away. Chad Berkley 04/03/2009 01:59 PM
5067 Bug New Normal The introduction of basic services so that module names are not referenced. David Welker 07/07/2010 10:22 AM
4511 Bug Resolved Low There are 2 toolbars in the Kepler main window Chad Berkley 10/28/2009 01:54 PM
5266 Bug Resolved Normal Two empty boxes inside Sinewave actor and other icon problems for attributes Christopher Brooks 12/07/2012 10:39 AM
5420 Bug Resolved Normal Two types of NPE issues when 2.2.0 installed and run by a non-admin windows user David Welker 06/13/2011 12:57 PM
3985 Bug Resolved Normal Types resolved to unacceptable types ben leinfelder 08/12/2009 12:39 PM
2412 Bug Resolved Immediate Unable to Create Kar file from composite Chad Berkley 04/12/2007 02:05 PM
5232 Bug Resolved Normal unable to open KARs saved beneath absent (e.g. third party) modules David Welker 01/28/2011 06:28 PM
3056 Bug Resolved Normal unable to print output of Display actor Christopher Brooks 03/21/2008 04:20 PM
3967 Bug Resolved Immediate Unable to run java -jar kepler-trunk.jar with -nogui -nocache -runwf fullworkflowpath options Chad Berkley 04/24/2009 04:46 PM
2315 Bug Resolved Normal Unable to run multiple Kepler instances simultaneously ben leinfelder 04/27/2009 10:19 AM
4022 Bug Resolved Normal undesired file:\ prefix added by FileParameter Derik Barseghian 08/04/2009 12:31 AM
3901 Bug Resolved Normal unescaped & in <entity name="a & b"> on line 4 Chad Berkley 03/18/2009 01:51 PM
4686 Bug Resolved Immediate update copyright statements Chad Berkley 02/05/2010 12:20 PM
1606 Bug Resolved Normal Update Kepler to work with Version 4.0 of Ptolemy Chad Berkley 07/19/2004 01:22 PM
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5170 Bug New Normal uploading a workflow requires a refresh Derik Barseghian 08/17/2015 08:56 AM
2471 Bug Resolved Normal 'Upload to Repository' menu throws an error Chad Berkley 07/07/2006 03:46 PM
3903 Bug New Low Use Java logging utilities instead of Apache commons logging facility Chad Berkley 04/21/2009 11:13 AM
4829 Bug New Normal User log4j files Derik Barseghian 02/23/2010 06:22 PM
4310 Bug New Immediate ValuelListeners receive valueChanged events when values have not changed Daniel Crawl 01/13/2010 03:28 PM
1999 Bug Resolved Normal Very long delays on first startup of new install Chad Berkley 05/16/2005 09:01 AM
5442 Bug Resolved Normal View->Automate Layout doesn't work in kepler-2.3 branch David Welker 09/26/2011 05:34 PM
4409 Bug Resolved Normal View Documentation for an actor works once Aaron Aaron 12/02/2009 12:23 PM
4595 Bug Resolved Normal ViewPane selection does not work with toolbar tear-off Chad Berkley 02/03/2010 11:48 AM
5446 Bug Resolved Normal View=>XML View broken David Welker 08/02/2011 04:25 PM
3899 Bug New Normal web service actor does not work through proxy Chad Berkley 04/03/2009 03:18 PM
4062 Bug Resolved Normal Web Services and Data Transformation demo throws a StringOutOfBounds Daniel Crawl 05/20/2009 09:06 AM
3219 Bug Resolved Normal White space in installation path fails on config file read Aaron Aaron 04/11/2008 02:12 PM
3466 Bug Works For Me Normal workflow can fail to load when using ParameterSet Chad Berkley 12/23/2015 02:16 PM
3264 Bug Resolved Normal workflow ENM/ASC2RAWTest gives an exception under ubuntu Chad Berkley 05/07/2008 04:19 PM
4313 Bug Resolved Normal Workflow Run Manager - duplicate rows shown for same execution Derik Barseghian 08/13/2009 02:03 PM
4149 Bug Resolved Normal Workflow Run Manager - Export Runs feature Derik Barseghian 06/25/2009 01:19 PM
4148 Bug Resolved Normal Workflow Run Manager - Upload to Repository feature Derik Barseghian 06/26/2009 10:29 AM
4619 Bug Resolved Normal WorkflowRuns not showing inside KARs in library Derik Barseghian 03/31/2010 05:59 PM
4019 Bug Resolved Immediate Workflow View in left pane Aaron Aaron 08/10/2009 04:23 PM
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